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Управление дисплеем МТ-12864J 
средствами микроконтроллера К1986ВЕ92QI

Графический дисплей MT-12864J компании МЭЛТ входит в комплект 

поставки отладочной платы микроконтроллера К1986ВЕ92QI компании 

«Миландр». Поэтому вопрос управления им интересует многих 

пользователей отладочного комплекта. Настоящая статья посвящена 

разработке дисплейного драйвера, совместимого с API драйверов 

графических дисплеев компании Keil и описываемого заголовочным 

файлом GLCD.h.

Андрей Шаронов, Валерий Володин (г. Пермь)

До недавнего времени авторы 

этой статьи в своих разработках не 

использовали графический дисплей 

MT-12864J, полагая его возможно-

сти избыточными и с успехом при-

меняя вместо него символьные дис-

плеи MT-16S2D и MT-20S4M. Наличие 

вариантов с напряжением питания 

3 В и Windows-совместимая встроен-

ная кодовая страница на базе CP1251 

делали дисплеи MT-16S2D и MT-20S4M 

удобным решением для большинства 

приборов.

Однако со временем возникла необ-

ходимость формировать не только тек-

стовые меню, но и графические изобра-

жения. Поэтому в перспективное изде-

лие был заложен дисплей MT-12864J. 

Для знакомства с возможностями дис-

плея для отладочной платы компании 

«Миландр» был разработан драйвер 

дисплея и ряд демонстрационных про-

ектов. В процессе разработки драйвера 

и демонстрационных программ были 

выявлены возможности дисплея, кото-

рые могут быть полезны и для прибо-

ров с полностью текстовым меню:

 ● возможность вывода на дисплей изо-

бражения, хранящегося в формате 

битового поля (например, логотипа 

компании);

 ● возможность инверсии тексто-

вой строки (светлый текст на тём-

ном фоне), что может быть исполь-

зовано для выделения активного 

пункта меню (в дисплеях MT16S2D 

и MT20S4M для этих целей исполь-

зуется символ указателя);

 ● бо′льшая вместимость дисплея: при 

использовании шрифта с размера-

ми знака 8 × 5 пикселей на дисплей 

возможно вывести 8 строк по 25 сим-

волов, а при использовании шриф-

та 8 × 6 пикселей возможно вывести 

8 строк по 21 символу.

К сожалению, более широкие воз-

можности дисплея ведут к усложне-

нию программного драйвера, и зада-

ча его разработки не выглядит столь 

тривиальной, как для символьных дис-

плеев.

ОБЩИЕ СВЕДЕНИЯ О ДИСПЛЕЕ 
МТ-12864J

Согласно спецификации на сай-

те производителя [1], основу дисплея 

MT-12864J составляют два микрокон-

троллера К145ВГ10 производства ком-

пании «Ангстрем». Каждый из них отве-

чает только за часть изображения. То 

есть для вывода изображения на левую 

половину дисплея (64 × 64 пикселя) 

необходимо выбрать один контрол-

лер, а для вывода изображения на пра-

вую – другой. Выбор соответствующего 

контроллера осуществляется установ-

кой сигнала логического нуля на выво-

де E1 или E2.

Для программиста каждый из кон-

троллеров представляет собой подо-

бие статического ОЗУ, разделённого 

на 8 страниц по 64 байта каждая. Каж-

дый байт может быть записан либо счи-

тан с помощью определённой последо-

вательности команд.

Обмен микроконтроллера с диспле-

ем производится по восьмиразряд-

ной параллельной шине, дополнен-

ной рядом управляющих сигналов. 

Назначение сигналов указано в табли-

це 1. Там же указаны и порты микро-

контроллера К1986ВЕ92QI (маркиров-

ка MDR32F9Q2I), к которым подключе-

ны соответствующие выводы дисплея.

Система команд одинакова для обо-

их контроллеров К145ВГ10 и представ-

лена в таблице 2.

Программисту доступны следующие 

команды:

 ● включение и выключение дисплея;

 ● установка верхней строки дисплея;

Таблица 1. Назначение выводов дисплея MT-12864J

Обозначение 
вывода Назначение вывода Номер вывода 

дисплея
Порт микроконтроллера К1986ВЕ92QI на 

отладочной плате (Rev. 2)

Ucc

Напряжение питания дисплейного 
модуля (цифровая часть) 1 –

GND Общий вывод 2 –

Uo Напряжение питания ЖК-панели 3 –

D0 Младший бит шины данных 4 PA0

D1 Первый бит шины данных 5 PA1

D2 Второй бит шины данных 6 PA2

D3 Третий бит шины данных 7 PA3

D4 Четвёртый бит шины данных 8 PA4

D5 Пятый бит шины данных 9 PA5

D6 Шестой бит шины данных 10 PF2

D7 Старший бит шины данных 11 PF3

E1 Выбор первого контроллера К145ВГ10 
(левая сторона дисплея) 12 PB7

E2 Выбор второго контроллера К145ВГ10 
(правая сторона дисплея) 13 PB8

RES Сброс дисплейного модуля 14 PB9

R/W Выбор режима: чтение или запись 15 PB10

A0 Выбор режима: команды или данные 16 PC0

E Стробирование данных 17 PC1

Uee Выход DC/DC-преобразователя 18 –

A «Плюс» питания подсветки 19 –

K «Минус» питания подсветки 20 –
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 ● установка активной страницы ОЗУ 

контроллера дисплея;

 ● установка активного байта ОЗУ кон-

троллера дисплея.

В режиме данных доступны функции 

чтения и записи. После чтения данных 

из активного байта активной страницы 

ОЗУ контроллера дисплея происходит 

инкремент адреса байта. Поэтому есть 

возможность последовательной запи-

си нескольких байтов в дисплей, что 

может ускорить определённые проце-

дуры чтения и записи.

Как и символьные дисплеи MT-16S2 

и MT-20S4, дисплей MT-12864J имеет 

регистр статуса, который считывает-

ся в режиме команд. Назначения битов 

регистра показаны в таблице 3.

Дисплей MT-12864J не имеет встро-

енного знакогенератора, поэтому обе-

спечение дисплея шрифтами – задача 

программиста. Это, с одной стороны, 

усложняет управляющую програм-

му, но с другой – позволяет создавать 

собственные шрифты, не ограничива-

ясь ни размерами, ни начертанием, ни 

кодовой таблицей (в символьных дис-

плеях компании МЭЛТ присутствуют 

только две кодовые таблицы: совме-

стимая с кодовой таблицей дисплеев 

на контроллере HD44700 и альтерна-

тивная, совместимая с CP1251). Кроме 

того, существует возможность инверс-

ного выделения текста.

API ДРАЙВЕРА ГРАФИЧЕСКОГО 
ДИСПЛЕЯ ОТ KEIL

Для подключения драйверов гра-

фических дисплеев компанией Keil 

разработан специальный программ-

ный интерфейс. Прототипы функций 

драйвера дисплея определены в заго-

ловочном файле GLCD.h и представле-

ны в таблице 4.

Данный файл можно найти, 

например, в каталоге типа C:\Ката-

лог установки Keil\ARM\Boards\Keil\

MCBSTM32C\LCD_Blinky (информация 

справедлива для версий Keil MDK 4.x. 

В Keil MDK 5 этот файл, возможно, 

содержится в пакете поддержки микро-

контроллеров STM32 или AT91SAM3x). 

Изначально, как можно увидеть из при-

меров программ (листингов), данный 

API предполагался для управления цвет-

ными графическими дисплеями, что 

следует и из наличия кодов, опреде-

ляющих различные цвета. Однако для 

монохромных дисплеев также возмож-

но создание драйверов, содержащих 

практически все функции, определён-

ные данным API и заголовочным фай-

Таблица 2. Система команд контроллера К145ВГ10

Команда
Код команды

Описание
DB7 DB6 DB5 DB4 DB3 DB2 DB1 DB0

Display ON/
OFF Control 0 0 1 1 1 1 1 LCD 

On/Off

Включение и выключение 
дисплея – определяется 
битом DB0:
0 – дисплей выключен,
1 – дисплей включён

Display Start 
Line 1 1 Display Start Line (0…63)

Определяет строку ОЗУ, 
которая будет отображаться 
в верхней строке дисплея

Set Page 1 0 1 1 1 Page (0…7) Установка активной страницы

Set Address 0 1 Address (0…63) Установка активной ячейки 
памяти выбранной страницы

Таблица 3. Структура регистра статуса дисплея

№ бита Название Значение по умолчанию Описание

0 – 0 Зарезервировано

1 – 0 Зарезервировано

2 – 0 Зарезервировано

3 – 0 Зарезервировано

4 Reset 0
Сброс дисплея:
1 – состояние сброса,
0 – нормальное состояние

5 On/Off 0
Включение и выключение дисплея:
1 – дисплей включён,
0 – дисплей выключен

6 – 0 Зарезервировано

7 Busy 0
Флаг занятости дисплея:
1 – дисплей занят,
0 – дисплей готов к работе

Таблица 4. Функции драйвера графического дисплея, определённые в файле GLCD.h

Функция Описание

void GLCD_init (void) Инициализация графического дисплея

void GLCD_WindowsMax (void) Установка максимального рабочего пространства дисплея

void GLCD_PutPixel (unsigned int x, 
unsigned int y)

Закраска пикселя с координатами x и y в цвет, определённый, как цвет 
текста

void GLCD_SetTextColor (unsigned short 
color)

Установка цвета, переданного в параметре color, как цвета выводимого 
на дисплей текста

void GLCD_SetBackColor (unsigned short 
color)

Установка цвета, переданного в параметре color, как цвета фона

void GLCD_Clear (unsigned short color) Очистка дисплея и заливка его цветом, определённым в параметре color

void GLCD_DrawChar (unsigned int x, 
unsigned int y, unsigned int cw, unsigned 
int ch, unsigned char *c)

Вывод на дисплей символа высотой ch и шириной cw в район точки, 
определённой координатами x и y (верхний левый край символа). 
Параметр *c является указателем на массив, определяющий начертание 
символа

void GLCD_DisplayChar (unsigned int ln, 
unsigned int col, unsigned char fi, unsigned 
char c)

Вывод на дисплей символа в строке ln и знакоместе col. Параметр fi 
определяет шрифт, параметр c – код выводимого символа

void GLCD_DisplayString (unsigned int ln, 
unsigned int col, unsigned char fi, unsigned 
char s)

Вывод на дисплей строки. Параметр ln определяет строку, параметр 
col – первое знакоместо, параметр fi – шрифт, параметр s – указатель на 
начало строки

void GLCD_ClearLn (unsigned int ln, 
unsigned char fi)

Очистка строки ln и закраска её цветом, определённым как цвет фона. 
Параметр fi определяет кегль очищаемой строки

void GLCD_Bargraph (unsigned int x, 
unsigned int y, unsigned int w, unsigned int 
h, unsigned int val)

Вывод на дисплей прямоугольника с началом в точке, определяемой 
параметрами x и y, с длиной w и высотой h. Параметр val определяет, 
какая часть прямоугольника будет закрашена в цвет текста, остальная 
часть красится в цвет фона

void GLCD_Bitmap (unsigned int x, 
unsigned int y, unsigned int w, unsigned int 
h, unsigned char bitmap)

Вывод на дисплей рисунка из битового поля. Параметры x и y – 
координаты начальной точки, w и h – длина и высота выводимого 
рисунка, bitmap – указатель на начало массива битового поля

void GLCD_ScrollVertical (unsigned int dy) Вертикальный сдвиг выведенной на дисплей информации на промежуток 
dy (в пикселях)

void GLCD_WrCmd (unsigned char cmd) Передача контроллеру дисплея команды cmd

void GLCD_WrReg (unsigned char reg, 
unsigned short val)

Запись в регистр контроллера reg значения val
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Начало

Установка режима 
записи команд или 
данных (вывод АО)

Установка 
в нулевое состоние 

выводов D0…D7

Настройка выводов 
D0…D7 на вывод 

информации

Перевод дисплея 
в режим записи 

(вывод R/W в логический 0)

Конец

Установка на 
выводе строба (Е) 

логической 1

Установка на 
выводах D0…D7 

записываемого байта

Сброс вывода строба 
в логический 0

Ожидание сброса 
флага занятости

Задержка

Задержка

лом. Название файла драйвера дисплея 

должно начинаться с GLCD. Напри-

мер, GLCD_SPI_STM32.c. Текст драйве-

ра дисплея MT-12864J находится в фай-

ле GLCD_MT12864.c.

Разработанный драйвер имеет ряд 

ограничений и особенностей, отли-

чающих его от прототипа:

 ● все цвета фона или текста, отличные 

от «белого», отображаются на дисплее 

«чёрным» цветом;

 ● драйвер поддерживает работу толь-

ко в горизонтальном режиме;

 ● в параметрах функции рисования 

прямоугольника переменная val 

отражает закраску в процентах, а не 

в долях 1/1024, как в прототипе;

 ● функция вывода рисунка предполага-

ет вывод чёрно-белых рисунков, име-

ющих 256 градаций серого;

 ● невозможна работа со стандартны-

ми шрифтами, прилагающимися 

к драйверу графического дисплея от 

Keil (организация памяти дисплея 

MT-12864J отличается от графических 

дисплеев, использованных в отладоч-

ных платах Keil и Atmel, поэтому более 

эффективно использовать специаль-

но адаптированные шрифты);

 ● отсутствуют команды установки раз-

мера окна и записи регистра.

Дисплей MT-12864J получил широкое 

распространение среди радиолюбите-

лей и профессионалов. Для различных 

микроконтроллеров были сделаны соб-

ственные драйверы данного дисплея, на 

которые авторы данной статьи опира-

лись в процессе разработки. В частности, 

драйвер для близкого по архитектуре 

дисплея MT-12864A, описанный в статье 

«Подключаем MT-12864-2YLG» [2].

ОСНОВНЫЕ ФУНКЦИИ 
ВЗАИМОДЕЙСТВИЯ С ДИСПЛЕЕМ

Основу драйвера дисплея составля-

ют следующие функции:

 ● начальная инициализация;

 ● передача дисплею команд и данных;

 ● чтение регистра состояния дисплея;

 ● чтение данных из памяти дисплея.

Данные функции позволяют реали-

зовать обмен данными с дисплеем для 

вывода на него различной информа-

ции – как текстов, так и графических 

изображений, что доступно для разра-

ботчика через функции драйвера.

В спецификации на дисплей [1] 

начальная настройка описывается как 

установка на входе RES состояния логи-

ческого нуля, удержание его в течение 

1 мкс и ожидание сброса флагов BUSY 

и RESET в регистре состояния дисплея.

Однако драйвер, представлен-

ный автором статьи «Подключаем 

MT-12864-2YLG» [2], предполагает более 

сложную процедуру инициализации:

Установка логического нуля на выво-

де RES с последующим его сбросом 

через 100 мс.

1. Выбор первого контроллера дисплея 

(К145ВГ10) установкой логической 

единицы на входе E1.

2. Отправка последовательности команд: 

включение дисплея, установка нуле-

вой ячейки текущей страницы ОЗУ 

в качестве активной, установка 

нулевой строки, как самой верхней 

(команды 0x3F, 0x40, 0xC0 соответ-

ственно).

3. Снятие сигнала выбора с первого 

контроллера и выбор второго кон-

троллера К145ВГ10 (установка логи-

ческой единицы на входе Е2 и логи-

ческого нуля на входе E1).

4. Повторение последовательности 

команд.

С программной реализацией данной 

функции можно ознакомиться в файле 

GLCD_MT12864.c любого из проектов, 

выложенных в дополнительных мате-

риалах к статье на сайте www.soel.ru 

(функция GLCD_init()).

В самом начале функции производит-

ся настройка всех портов, на выводах 

которых формируются сигналы управ-

ления дисплеем (см. табл. 1). В дальней-

шем все управляющие сигналы уста-

навливаются в состояние логическо-

го нуля, в том числе и сигнал сброса. 

Через 100 мс сигнал сброса восстанав-

ливается в состояние логической еди-

ницы. После этого установкой логиче-

ской единицы на выводе E1 выбирается 

первый контроллер К145ВГ10 дисплея, 

отвечающий за левую половину экра-

на. Контроллеру передаются команды 

включения дисплея, установки актив-

ной ячейки памяти и первой отобра-

жаемой строки.

После передачи команд сигнал выбо-

ра контроллера снимается и выбира-

ется второй контроллер, отвечающий 

за правую половину дисплея. Функ-

ция ожидает снятия сигнала занято-

сти контроллера и снова передаёт те 

же команды.

Временны′ е диаграммы сигналов на 

выводах дисплея показаны в специфи-

кации [1]. Гораздо интереснее посмо-

треть, как это выглядит с точки зрения 

программиста. Блок-схема алгоритма 

записи байта в контроллер показана 

на рисунке 1, программная реализа-

ция содержится в функции LCD_write() 

Рис. 1. Блок-схема алгоритма записи байта 

в контроллер дисплея
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Начало
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Установка 
в нулевое состоние 
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Настройка выводов 
D0…D7 на вход

Перевод дисплея 
в режим чтения 

(вывод R/W в логическую 1)

Конец

Установка на 
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логической 1

Чтение данных 
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Сброс вывода строба 
в логический 0

Задержка

Задержка

Пока считывается флаг 
занятости дисплея

файла GLCD_MT12864.c из дополни-

тельных материалов к статье.

Как видно из листинга, в функции 

отсутствуют процедуры ожидания 

сброса сигнала занятости и перевода 

дисплея в режим команд или режим 

данных. Эти операции вынесены из 

функции и реализуются в отдельных 

функциях: передачи команд и передачи 

данных, описанных в лис тингах 1 и 2.

Как видно из листингов и блок-схемы 

алгоритма, ожидание сброса сигна-

ла занятости вынесено в отдельную 

функцию. Блок-схема алгоритма ожи-

дания сброса сигнала занятости показа-

на на рисунке 2, а программная реали-

зация данного алгоритма представлена 

в функциях файла GLCD_MT12864.c – 

LCD_read_status() и LCD_wait_busy() 

соответственно.

Как и в случае записи, считывание 

байта и ожидание сброса флага реали-

зованы в разных функциях. Аналогич-

но чтению регистра статуса реализова-

на функция чтения данных из дисплея. 

В этот раз авторы не стали делать одну 

функцию чтения байта. Единственное 

отличие функции чтения данных (LCD_

read_data()) в том, что дисплей пере-

водится в режим данных сигналом на 

выводе A0.

Ещё одна функция – очистка дисплея, 

которая заливает весь дисплей цветом, 

указанным, как цвет фона. Фактически, 

всё сводится к записи в каждую ячейку 

памяти значения 0x00 или 0xFF. С про-

граммной реализацией данной функ-

ции также можно ознакомиться в фай-

ле GLCD_MT12864.c – функция GLCD_

Clear().

ФУНКЦИИ РАБОТЫ С ТЕКСТОМ

Основной задачей дисплея является 

вывод текстовой информации. Поэтому 

следующими по важности после функ-

ций инициализации и обмена данны-

ми с контроллером являются функции 

вывода на экран текстовой информа-

ции. Так как дисплей не имеет собствен-

ного знакогенератора, то актуальным 

является вопрос выбора шрифтов, кото-

рые будут использоваться для вывода 

текстов.

В составе примеров Keil поставляют-

ся два шрифта: 6 × 8 и 12 × 16 пиксе-

лей. Однако структура данных шриф-

тов для дисплея MT-12864J не является 

оптимальной. На рисунке 3 показана 

структура символа «1» для шрифта 8 × 6, 

предлагаемого компанией Keil (файл 

Font_6x8h.h). Как видно из рисунка, 

символ представляет собой массив 

значений, каждое из которых описы-

вает расстановку пикселей в одной из 

восьми строк.

Для дисплея MT-12864J более подхо-

дящим является шрифт, структура кото-

рого показана на рисунке 4. Здесь зна-

чения массива описывают расстановку 

пикселей в столбцах. Такой структуре 

соответствует шрифт в проекте «Под-

ключаем MT-12864-2YLG» [2] (размер 

символа 5  8 пикселей), однако табли-

ца шрифта несовместима с CP1251, что 

ведёт к усложнению функции вывода 

символов на дисплей.

В обсуждении на форуме разработчи-

ков электроники [3] был выложен про-

ект с комплектом из четырёх шриф-

тов, совместимых с кодовой таблицей 

CP1251 [4]. Каждый шрифт находится 

Листинг 1

static void LCD_write_cmd (unsigned char cmd)

{

 LCD_wait_busy();   //Ожидание сброса сигнала 

занятости дисплея

 MDR_PORTC->RXTX &= ~A0; //Перевод дисплея в режим команд

 LCD_write(cmd);   //Запись байта в дисплей

}

Листинг 2

static void LCD_write_data (unsigned char data)

{

 LCD_wait_busy();   //Ожидание сброса сигнала 

занятости дисплея

 MDR_PORTC->RXTX |= A0; //Перевод дисплея в режим данных

 LCD_write(data);   //Запись байта в дисплей

} Рис. 2. Блок-схема алгоритма ожидания 

сброса сигнала занятости
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в отдельном заголовочном файле. Поль-

зователю доступны шрифты размером 

символа 6 × 8, 12 × 16 пикселей, а также 

два шрифта размером 7 × 10 пикселей: 

нормальный и полужирный.

Для использования данных шриф-

тов вместе с программой в файлы были 

внесены определённые изменения:

● удалена структура FONT, описываю-

щая параметры шрифта;

● удалено подключение заголовочно-

го файла display.h;

● тип массива шрифтов изменён 

с __flash BYTE на const unsigned char.

После внесения изменений заголо-

вочные файлы с таблицами знакоге-

нератора были подключены к проек-

ту. Непосредственный вывод символа 

на дисплей осуществляется функци-

ей GLCD_DrawChar(), среди параме-

тров которой передаются координа-

ты начальной точки символа, ширина 

и высота символа, а также указатель 

на массив, описывающий начерта-

ние символа в таблице знакогенерато-

ра (см. табл. 4). В качестве прототипа 

была взята функция вывода символов 

на дисплей из проекта «Подключаем 

MT-12864-2YLG» [2].

Данная функция позволяет выво-

дить на дисплей символы с произ-

вольным расположением начальной 

точки, поэтому предусмотрена воз-

можность вывода символа, не впи-

сывающегося в одну страницу. Для 

символов размером 7 × 10 пикселей 

предусмотрена также возможность 

вывода символа, не вписывающегося 

в две страницы. Также драйвер пред-

усматривает функции вывода симво-

ла с указанием строки и знакоместа 

и вывода символьной строки: GLCD_

DisplayChar() и GLCD_DisplayString() 

соответственно. В качестве параметра 

fi передаётся тип шрифта, использу-

емого при выводе символа. В прото-

типе данный параметр может прини-

мать значение «0» для шрифта 6 × 8 

пикселей и «1» для шрифта 12 × 16 пик-

селей. В разработанном драйвере зна-

чение «0» соответствует шрифту 6 × 8 

пикселей, значение «1» соответствует 

нормальному шрифту 7 × 10 пикселей, 

значение «2» соответствует полужир-

ному шрифту 7 × 10 пикселей, а значе-

ние «3» – шрифту 12 × 16 пикселей. На 

рисунке 5 показаны все четыре шриф-

та на экране дисплея.

Также для работы с текстовой инфор-

мацией предназначена функция очист-

ки строки. В примерах Keil данная зада-

ча решается выводом на дисплей стро-

ки с пробелами. Так как разработанный 

драйвер использует шрифты с шири-

ной, не кратной 8 (что не позволяет 

заполнить всю строку целым количе-

ством пробелов), был применён метод, 

сходный с очисткой дисплея: заполне-

ние всех ячеек памяти выбранной стра-

ницы памяти значениями 0x00 или 

0xFF в зависимости от установленно-

го цвета фона. Для шрифта 7 × 10 пик-

селей была предусмотрена ситуация, 

когда очищаемая строка занима-

ет страницу только частично. Фраг-

мент кода, иллюстрирующий очистку 

строки высотой 8 пикселей, приведён 

в листинге 3.

ГРАФИЧЕСКИЕ ФУНКЦИИ

Практически все графические воз-

можности драйвера базируются на 

функции вывода на экран пикселя 

с заданными координатами. Данная 

функция также взята из проекта «Под-

ключаем MT-12864-2YLG» [2] и сводит-

ся к следующей последовательности 

операций:

1. Выбор страницы и байта, где будет 

находиться значение, описывающее 

положение пикселя на экране.

2. Считывание байта.

3. Модификация байта.

4. Запись изменённого значения обрат-

но в ячейку памяти.

Программно данная процедура реа-

лизуется функцией GLCD_PutPixel() 

драйвера GLCD_MT12864.c.

Данная функция используется для 

вывода на экран прямоугольника 

в функции GLCD_Bargraph(). Сначала 

в цикле производится вывод на экран 

границ прямоугольника, а после – 

заливка цветом текста части, опре-

делённой параметром val в процен-

тах, и остальной части – цветом фона. 

С программной реализацией данной 

функции также можно ознакомиться 

в тексте драйвера GLCD_MT12864.c.

Наиболее интересной является функ-

ция вывода битового поля GLCD_

Bitmap(). Данная функция позволя-

ет вывести на дисплей рисунок, опи-

санный в виде массива значений. Для 

получения такого массива значений 

в составе среды Keil uVision присут-

ствует программа Bitmap converter for 

Листинг 3

LCD_write_cmd(0xC0);   //Установка начальной строки

//Установка страницы памяти, соответствующей стираемой строке

LCD_write_cmd(0xB8 | page);

//Стирание строки путем записи значений, соответствующих цвету фона

for (i=0; i<64; i++)

{

 if (Color[BG_COLOR]==White)

  LCD_write_data(0x00);

 else

  LCD_write_data(0xFF);

}

Рис. 3. Структура символа шрифта из файла 

Font_6x8h.h, входящего в примеры Keil

Рис. 4. Структура символа шрифта, 

рекомендуемого для дисплеев типа MT-12864

Рис. 5. Доступные шрифты на экране 

дисплея
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emWin (C:\Каталог установки Keil\ARM\

Segger\emWin\Tool\BmpCvt.exe).

Данная программа позволяет конвер-

тировать любое графическое изобра-

жение в различные цветовые форматы, 

а также сохранять его либо в форма-

те BMP, либо в виде файла с расшире-

нием *.c, содержащего массив, описы-

вающий изображение в виде битово-

го поля.

На взгляд авторов, формат лучше все-

го подходит для преобразования изо-

бражений типа «256 градаций серого». 

В этом случае каждый пиксель изобра-

жения описывается одним байтом мас-

сива, что облегчает работу с ним.

Для преобразования необходимо 

открыть исходный графический файл 

командой File->Open. В окне програм-

мы откроется графический файл, а так-

же будут выведены его параметры: раз-

решение, цветовой формат и коэффи-

циент увеличения программой – zoom 

(см. рис. 6).

Преобразование цветовой гаммы осу-

ществляется в меню, выпадающем по 

команде Image->Convert Into (см. рис. 7).

После преобразования в режим «256 

градаций серого» (Gray256) изображе-

ние выглядит так, как это показано на 

рисунке 8.

Сохранить преобразованное изобра-

жение можно командой File->Save As. 

В выпадающем меню можно выбрать 

тип файла. В данном случае это будет 

«C» bitmap file. После нажатия на кноп-

ку сохранения появится диалоговое 

окно выбора формата, в котором будет 

сохранён массив, описывающий изо-

бражение. Здесь можно выбрать дру-

гой формат, не соответствующий тому, 

в который было преобразовано изо-

бражение (например, можно преобра-

зовать исходное изображение в фор-

мат с четырьмя градациями серого, но 

сохранить в формате «256 градаций 

серого»). После выбора формата и нажа-

тия кнопки «OK» файл будет сохранён.

Сохранённый файл содержит следу-

ющие элементы:

 ● палитру – массив цветов static GUI_

CONST_STORAGE GUI_COLOR;

 ● структуру, описывающую параметры 

массива палитры static GUI_CONST_

STORAGE GUI_LOGPALETTE;

 ● массив битового поля static GUI_

CONST_STORAGE unsigned char;

 ● структуру, описывающую битовое 

поле GUI_CONST_STORAGE GUI_

BITMAP.

Для демонстрационного проек-

та будет достаточно массива битово-

го поля. Однако структура, описыва-

ющая битовое поле, имеет ряд полез-

ных параметров, которые желательно 

также сохранить в тексте программы.

Авторы поместили массив битово-

го поля в заголовочный файл, изме-

нив его тип на static unsigned char (воз-

можно также указать тип const unsigned 

char). Размер изображения в пикселях 

функция вывода на дисплей битового 

поля получает в качестве параметров 

(см. табл. 4). В каждом байте массива 

находится значение, определяющее 

степень градации серого у описывае-

мого пикселя. Значение 0x00 соответ-

ствует «чёрному» пикселю, а значение 

0xFF – «белому». Остальные значения 

описывают различные степени града-

ции серого. Так как дисплей MT-12864J 

может воспроизводить только «белые» 

и «чёрные» пиксели, то в функции про-

изводится сравнение значения элемен-

та массива с числом 0x7F, на основа-

нии результатов которого определяет-

ся цвет пикселя. Если число в массиве 

больше 0x7F, то цвет пикселя «белый». 

В противном случае пиксель закра-

шивается «чёрным» цветом. Фрагмент 

функции вывода на дисплей битового 

поля показан в листинге 4.

Образец выведенного на дисплей 

преобразованного графического изо-

бражения показан на рисунке 9. 

В определённых случаях оказыва-

лось, что с «границей белого», равной 

0x7F, качество изображения страдало 

(см. рис. 10), а само изображение полу-

чалось более контрастным в режиме 

четырёх градаций серого (см. рис. 11).

Последней функцией драйвера, 

используемой для работы с графиче-

скими, а также текстовыми объекта-

Листинг 4

for (i=0; i<lim_Y; i++)

{

 for (j=0; j<lim_X; j++)

 {

  if (bitmap[i*w+j]>0x7F)

  //if (bitmap[i*w+j]==0x03)

  {

   Color[TXT_COLOR]=White;

  }

  else

  {

   Color[TXT_COLOR]=Black;

  }

  GLCD_PutPixel(x+j, y+i);

 }

}

ми, является функция вертикально-

го скроллинга. В настоящем драйвере 

она реализована методом копирова-

ния одной области экрана в другую 

с помощью массива. Блок-схема алго-

ритма приведена на рисунке 12.

Рис. 6. Изображение, открытое в программе 

Bitmap converter for emWin

Рис. 7. Меню преобразования цветовой гаммы 

изображения

Рис. 8. Изображение после преобразования
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Начало

Конец

Да

Нет

Определение количества страниц 
и количества бит, на которые 

производится сдвиг

Считывание страницы, 
содержимое которой будет 

располагаться в самом низу, 
в буфер

Запись содержимого 
буфера в последнюю 

страницу

Пока не скопирована 
нулевая страница

Считывание переносимой 
страницы в буфер

Запись первой половины 
страницы

Запись второй половины 
страницы

Величина сдвига 
кратна 8?

Заполнение оставшегося 
пространства цветом фона

Программно данный алгоритм реали-

зуется функцией GLCD_ScrollVertical() 

драйвера дисплея.

Драйвер дисплея был испытан на 

отладочной плате микроконтролле-

ра К1986ВЕ92QI и показал хорошие 

результаты. В дальнейшем, с внесением 

определённых изменений, планируется 

его использование для реализации раз-

личных меню в разрабатываемых при-

борах и устройствах [5].
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